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CHAPTER

ONE

OVERVIEW

Fig. 1.1: Xena2544 overview

This the user manual for Xena2544. Xena2544 is a Windows application that enables you to
perform advanced network tests according to the RFC 2544 using one or more of the Xena test
equipment chassis.

The Xena2544 application features the following capabilities:

• Enables the user to create, edit and execute test configurations using Xena Networks test
equipment in accordance with RFC 2544.

• Full support for the 4 test-types specified in RFC 2544.

• Ability to partially enable one or more of the test-types.

• Support for multiple XenaBay and XenaCompact test chassis.

• Support for different network topologies and traffic flow directions.

• Support for both layer 2 and layer 3 testing.
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• Support for either IPv4 or IPv6.

• Ability to flexibly define the protocol layers supported by the test (Ethernet, Customer
and Service VLANs, IP and UDP).

• Ability to specify different protocol headers for each port.

• Ability to set modifiers on virtually any protocol field in the protocol headers using a
Wireshark-like tree view.

• Support for asymmetric port rates and DUT throughput rates. The Throughput test can
be configured to either measure the least common throughput rate or measure a per-port
rate.

• Test reports can be created in either PDF, XML or CSV format or any combination thereof.

• Extensive configuration options to fine-tune the tests.

4 Chapter 1. Overview



CHAPTER

TWO

INSTALLATION

Xena2544 is a Windows desktop application compatible with Windows 8 and later versions.

It comes pre-installed as an integral component of the standard Xena software release package,
which is available for download from this source.

Following the installation, you can locate a shortcut to the application in the Start → Programs
→ Xena Network menu, and additionally (if you opted for this during the setup process), on
your desktop.

5
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CHAPTER

THREE

AVAILABLE TESTS

This section describes the test available in Xena2544. They closely follow the definition in the
RFC 2544 Section 26.

3.1 Throughput Test
Defined in RFC 2544 Section 26.1, the Throughput test is an iterative test that attempts to
find the throughput for a Device Under Test (DUT ). RFC 1242 defines the throughput as “The
maximum rate at which none of the offered frames are dropped by the device”.

The test uses a binary search algorithm to locate the throughput rate. One iteration of the test
will produce a single test result.

3.2 Latency/Jitter Test
Defined in RFC 2544 Section 26.2, the Latency/Jitter test is also a rate sweep test that attempts
to determine the latency and jitter for a DUT throughout a defined range of input data rates.
RFC 1242 broadly defines latency as the time it takes for a frame to traverse the DUT, but the
precise definition depends on the type of forwarding used in the DUT.

Latency is also known as the Frame Transfer Delay (FTD). Jitter is not defined in this RFC but
is defined as the variation in latency over time. It is also known as the Frame Delay Variance
(FDV ).

The test measures the average, maximum and minimum latency and jitter values at a series of
input rates defined by an initial value a, maximum value and a step value. One iteration of the
test will produce a test result for each rate in the series.

3.3 Frame Loss Test
Defined in RFC 2544 Section 26.3, the Frame Loss test is a rate sweep test that attempts to
determine the frame loss rate for a DUT throughout a defined range of input data rates. RFC
1242 defines the loss as the “percentage of frames that should have been forwarded by a network
device under steady state (constant) load that were not forwarded due to lack of resources”.

The test measures the frame loss at a series of input rates defined by an initial value a, maximum
value and a step value. One iteration of the test will produce a test result for each rate in the

7
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series.

3.4 Back-To-Back Test
Defined in RFC 2544 Section 26.4, the Back-to-Back test is a combination of an iterative test
and a rate sweep test that characterizes the ability of a DUT to process back-to-back frames at
various rates. RFC 1242 defines back-to-back frames as “fixed length frames presented at a rate
such that there is the minimum legal separation for a given medium between frames over a short
to medium period of time, starting from an idle state”. The test attempts to locate the maximum
number of frames that can be sent back-to-back at a given rate without any frame loss. This is
also known as the “burst size”.

The test uses a binary search algorithm to locate the burst size at a given rate. One iteration of
the test will produce a single test result for each input rate used.

8 Chapter 3. Available Tests
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CHAPTER

FOUR

GETTING STARTED

This manual contains some examples of basic Xena2544 configurations to get you started using
the application.

4.1 Step-By-Step Guide

4.1.1 Add Chassis

Click the Add Chassis button.

Enter the IP of the Management port under Chassis Address. Use xena as default Chassis
Password.

9
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4.1.2 Add/Configure Port/s

Select the Port(s) you need to use.

1. Set port addresses

2. Configure Physical Port Properties

3. Choose rate cap

4. Configure peer negotiation (depending on the module you use, some properties are not
applicable.)

10 Chapter 4. Getting Started
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ã See also

Check Selected Ports Panel for details.

4.1.3 Protocol Segment Profiles

1. Add new profile.

2. Select the new profile.

3. Add additional headers.

4. Choose Segment.

ã See also

Check Protocol Segment Profile Panel for details.

4.1.4 Test Configuration
1. Choose topology and traffic direction

2. Set frame size

3. Configure test payload

1. Configure flow creation

2. Configure port scheduling

3. Configure MAC Learning Options

4.1. Step-By-Step Guide 11
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4. Configure ARP/NDP Learning Options

5. Configure Flow-based Learning Options

6. Configure Reset and Error Handling

Configure throughput test properties.

Configure latency test properties.

Configure frame loss test properties.

Configure back-to-back test properties.

ã See also

Check Test Configuration Panel for details.

4.1.5 Multi-Stream configuration
Configure multi-stream, if needed.

4.1. Step-By-Step Guide 13
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ã See also

Check Multi-Stream Configuration for details.

4.1.6 Reporting

Select the report format you want to generate.

ã See also

Check Report Options Panel for details.

4.1.7 Save and Start
Start the test. Xena2544 will automatically reserver the ports and ask you to save the test con-
figuration.

4.2 Layer-2 Tests
This section describes various layer-2 (Ethernet with optional VLAN) tests.

4.2. Layer-2 Tests 15
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4.2.1 Ethernet Point-to-Point Test
This example will describe how a simple pair-based unidirectional test using plain Ethernet
transport with two test ports is created and executed.

Start the Xena2544 application. Select the File → New menu option to ensure that you start
with a new configuration.

Push the Add Chassis button in the toolbar and enter the IP address and password of the Xena
tester you want to use. Keep the default value of 22606 for the port number unless you know
that your tester is configured with a different port number. Press OK.

Fig. 4.1: Add chassis

The Xena2544 will now connect to the chassis and read all module and port information. You
should now see all available test modules and ports on the chassis in the Physical Ports panel to
the left.

Change to the Test Configuration tab. In the Topology and Frame Content subtab set the Topol-
ogy property to Pairs and the Direction property to East -> West. Leave all other properties in
this subtab and the other two subtabs at their default values.

Fig. 4.2: East-to-west topology

Change to the Selected Ports tab. Locate two ports in the Physical Ports panel which you want
to use in the test and drag them to the Selected Ports tab. Note that these two ports should

16 Chapter 4. Getting Started
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be able to communicate with each other using plain Ethernet transport. Either they should be
connected to the same layer-2 switch or they could be connected together using a cable.

Set the Port Group property for the first port to East. Set the same property for the other port
to West.

Press the red Select Peer selector in the Port Peer column for the first port. Select the other port
in the resulting drop-down box, as shown in the figure below. The equivalent selector for the
other port will change automatically.

Fig. 4.3: Port group

Change to the Reporting tab and ensure that the Generate PDF Report option is checked. Also
ensure that the Open report in Associated Viewer option in the Options menu is checked.

Press the Save Configuration tool icon in the toolbar (or select the File → Save menu item).
Enter a suitable filename for the configuration.

Press the Start button in the toolbar. Your test will now start and the progress will be indicated
in the status line at the bottom of the GUI.

When all 4 tests have completed the generated PDF report will automatically be shown in the
associated PDF viewer.

4.2.2 Adding VLAN Tag
This example will expand on the previous example and show how to add a VLAN protocol
segment to the test.

Open the configuration file used in the previous example. You may optionally save it under a
new name if you want to preserve the original.

Change to the Protocol Segment Profiles tab. At the top you will see a list of existing profiles.

4.2. Layer-2 Tests 17
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Fig. 4.4: Reporting

Fig. 4.5: Test done

18 Chapter 4. Getting Started
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Fig. 4.6: Protocol segment profile

Select the profile labeled Ethernet / VLAN (0). This is a predefined profile created by the
Xena2544 as a convenience for you. We will however need to modify it a bit.

When you select the profile the tree iew below the profile list will be populated with the available
protocol segments in the profile. Expand the VLAN branch and locate the VLAN Tag field.
Change the value to e.g. 10.

You should now see that the profile label changes to Ethernet / VLAN (10).

Change to the Selected Ports tab. Change the Protocol Segment Profile value for each of the
two ports to the profile we just edited.

ò Note

If you select both ports using Ctrl-click you can change this value for both ports simulta-
neously.

ò Note

You can also right-click and select Use Value For All to quickly apply to all ports.

Press the Start button in the toolbar to start the test.

4.2. Layer-2 Tests 19
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Fig. 4.7: Set VLAN tag 10

Fig. 4.8: VLAN tag 10 profile

20 Chapter 4. Getting Started
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Fig. 4.9: User protocol segment profile on port

4.3 Layer-3 Tests
This section describes various Layer-3 (IP) tests.

4.3.1 IPv4 Point-to-Point Test
This example will describe how a simple pair-based bidirectional test using IPv4 transport with
two test ports is created and executed.

Start the Xena2544 application. Select the File → New menu option to ensure that you start
with a new configuration.

Add a chassis to the test configuration.

Change to the Test Configuration tab. In the Topology and Frame Content subtab set the Topol-
ogy property to Pairs and the Direction property to Bidirectional. Leave all other properties in
this subtab and the other two subtabs at their default values.

Change to the Selected Ports tab. Locate two ports in the Physical Ports panel which you want
to use in the test and drag them to the Selected Ports tab. Note that these two ports should be
able to communicate with each other using IPv4 transport.

Set the Port Group property for the first port to East. Set the same property for the other port
to West.

Set the two ports as each others peer using the Port Peer property.

Set the Protocol Segment Profile for each port to the Ethernet / IPv4 profile.

Configure each port with an appropriate IP address and prefix. Also add the address of the
associated IP gateway if the two ports are located in separate IP subnets.

4.3. Layer-3 Tests 21
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Fig. 4.10: IPv4 protocol segment profile

Press the Start button in the toolbar to start the test.

4.3.2 IPv4/UDP Blocks Test
This example will expand on the previous example and show how to change the topology and
the number of frame sizes used in the test. Open the configuration file used in the previous
example. You may optionally save it under a new name if you want to preserve the original.

Change to the Test Configuration tab. In the Topology and Frame Content subtab set the Topol-
ogy property to Blocks and the Direction property to Bidirectional.

In the Frame Sizes section ensure that the Custom Sizes property is selected. Enter the frame
sizes 128, 512 and 1024 separated by commas in the field next to this property.

Fig. 4.11: Custom sizes

Change to the Selected Ports tab. Set the Protocol Segment Profile value for each of the two

22 Chapter 4. Getting Started
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ports to the Ethernet / IPv4 / UDP profile.

Press the Start button in the toolbar to start the test. The tests will now be performed for all the
defined frame sizes.

4.3.3 IPv6 Mesh Test
This example will again expand on the previous example and show how to create and configure
a new protocol segment profile. Open the configuration file used in the previous example. You
may optionally save it under a new name if you want to preserve the original.

Change to the Test Configuration tab. In the Topology and Frame Content subtab set the Topol-
ogy property to Mesh. The Direction will be forced to Bidirectional as all mesh flows are bidi-
rectional by definition.

Fig. 4.12: Mesh topology

Change to the Protocol Segment Profiles tab. Press the Add Profile button below the profiles
list view. A new profile with an Ethernet segment will be appended to the list view.

Select the new profile and press the Add Segment button in the command panel to the right.
A dialog showing all possible segment definitions will be shown. Locate the IPv6 segment
definition in the list and press OK.

Change to the Selected Ports tab. Set the Protocol Segment profile value for each of the two
ports to the new Ethernet / IPv6 profile.

Configure each port with an appropriate IP address and prefix. Also add the address of the
associated IP gateway if the two ports are located in separate IP subnets.

Press the Start button in the toolbar to start the test.

4.3. Layer-3 Tests 23
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Fig. 4.13: Edit protocol segment profile

Fig. 4.14: Use IPv6 protocol segment profile

24 Chapter 4. Getting Started
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FIVE

GENERAL PANELS

The main Xena2544 application screen is shown in the image below.

Fig. 5.1: Xena2544 application screen

The application is using a tabbed panel layout in order to divide the functionality into separate
functional areas. The following sections will provide a brief explanation of the main areas of
the GUI.

5.1 Menu Bar and Toolbar
The menu bar at the top provides access to general functionality:

• File

Contains options to load and save test configurations. Also contains a “Most Recently
Used” list of the last 4 test configurations you have opened.

• Edit

25
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Contains options to specify and edit the Xena tester chassis used by the test configuration.

• View

Enables you to show or hide the various panels in the application.

• Test Control

Contains options to start, stop or cancel the execution of a test configuration.

• Options

Contains various application-level options for the Xena2544 application. These options
are thus not associated with individual test configurations but are valid for the application
as a whole.

• Help

Provides links online manuals (such as this manual)

The toolbar provides easy shortcuts to the most frequently used menu functions.

5.2 Application Panels
The application panels are contained in the tabbed panel which takes up the center part of the
GUI.

• Start Page

This panel contains a short Quick Start guide. Once you feel that this information is no
longer needed you can close the panel using the small x at the right of the panel bar.

• Test Configuration

This panel contains all test configuration options. It is sub-divided into tree sub-panels.

• Selected Ports

This panel allows you to include Xena test ports in your test and to configure the behavior
of these ports.

• Protocol Segment Profiles

This panel allow you to configure the various protocol segment profiles in the configura-
tion. You can modify existing profiles, add new profiles, and also remove profiles you do
not need.

• Reporting Options

This panel contains configuration options related to reporting of test results.

The function of the various panels are explained in more detail in the following sections.

26 Chapter 5. General Panels
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5.3 Status Line

Fig. 5.2: Xena2544 progress status bar

The status line at the bottom provides information about the current test progress. It contains
the following fields:

• Progress Bar

Shows the progress of the current test. The number of “steps” in the progress bar is the
total number of trials in the test, which is equal to the number of iterations multiplied with
the number of frame sizes defined. For tests using a predefined rate sweep vector (latency,
loss and back-to-back) the number of rates are also factored in.

• Information

A text field showing the current activity of the test.

• Test State

A state field showing whether the test is running or not.

• Test Time

Shows the total elapsed test time, including delays between test trials.

• Duration

Show the duration progress for the current test trial. When traffic is not enabled the text
is grayed out.

• User

The username for the current chassis session.

5.3. Status Line 27



Xena2544 User Manual, Release 106.1

28 Chapter 5. General Panels



CHAPTER

SIX

PHYSICAL PORTS PANEL

This panel displays all available ports on the currently connected Xena chassis. It is possible to
connect to multiple Xena chassis at the same time.

Fig. 6.1: Physical ports panel

It also allows you to perform the following actions:

• View the current sync (link) and traffic state of the ports.

• View the current ownership of the ports.

• Request or relinquish ownership of ports.

• Determine which ports are used in the test configuration.

29
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6.1 Port States
The column to the right of the port names contain two state bullet icons.

The first bullet indicate the port sync (link) state. A green bullet means that the port is in sync
and a red bullet means that the port has lost sync.

The second bullet indicate the traffic state. A yellow bullet means that traffic is being sent from
the port. A gray bullet means that no traffic is active.

6.2 Using Ports in Your Test
Right-clicking on a port allow you to either add or remove the port from the test configuration.
If you use either Shift-click or Ctrl-click to select multiple ports it is possible to add or
remove multiple ports at the same time. Right-clicking on a module allow you to add/remove
all ports on that module.

Instead of right-clicking on ports you can also select and drag the ports to the Selected Ports
panel.

6.3 Port Ownership
The right-most column display the username of the current port owner. Ports that are free (i.e,.
not owned by anyone) are displayed with a normal font. Ports that are owned by you are displayed
with a bold font. Port owned by other users are displayed using a gray font.

You can reserve or relinquish ownership of a port by right-clicking on it and selecting the ap-
propriate action. It is also possible to right-click on a module to perform the same operations on
all ports on the module. Note that the Xena2544 will automatically reserve ownership of used
ports when a test is started.

30 Chapter 6. Physical Ports Panel
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SEVEN

TEST CONFIGURATION PANEL

This panel contains all properties related to the execution of the tests.

7.1 Topology and Frame Content

Fig. 7.1: Test configuration panel

7.1.1 Test Topology
These properties define the topology and direction of the test traffic:

• Pairs: Each test port is placed in either the East or the West block. Then the ports are
paired together two and two. Traffic is only flowing between paired ports. The Direction
option determines which ports will be transmitting.

• Blocks: Each test port is placed in either the East or the West block. Every port in the
transmitting block sends traffic to every port in the other block. The Direction option
determines if only one block or both will be transmitting.

• Mesh: All test ports send traffic to all other test ports. The Direction option is ignored as
Mesh traffic is always bidirectional.

31
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7.1.2 Frame Sizes
This section allow you to specify the frame sizes to be used by the various tests. The available
frame size options are divided into two groups, the Fixed Sizes Per Trial and the Varying Sizes
Per Trial.

As the name indicates the Fixed Sizes Per Trial group uses a single frame size per trial. It is
possible to specify multiple frame sizes which will cause the test to be repeated for each frame
size.

The Varying Sizes Per Trial group will use many frame sizes for each trial. This is controlled
by the hardware. Note that when calculating bit rates the average frame size will be used.

7.1.3 Frame Test Payload
The normal Xena test payload (TPLD) section takes up 20 bytes and is used for various purposes,
such as latency measurements, loss and misordering monitoring, payload integrity, etc. Due to
this test payload it may be impossible to make room for protocol headers such as IPv4+UDP for
smaller frame sizes (e.g. ~64 byte).

By enabling the Use Micro-TPLD if needed option you permit Xena2544 to use the smaller
micro-TPLD if needed by the current frame size. The consequence of this will be that realtime
monitoring of packet loss is no longer possible.

ò Note

Note that Xena2544 will only use the micro-TPLD for a test run if the current frame size
requires it. If you for instance use the default IEEE packet size distribution you may encounter
that the micro-TPLD is only used for 64 byte packets but not for the other packet sizes.

The Payload Type property defines the type of test payload in the frames generated by the test
ports. If the payload type is set to “Pattern” you can specify the pattern in the Pattern field.

7.2 Test Execution Control

7.2.1 Flow Creation
These properties determine how the test flows between ports are created.

Stream-Based Flows

The default Stream-based setting will use one Xena stream for each flow from one port to an-
other. This enables fine-grained per-port statistics and also allow you to specify field modifiers
for various protocol fields. But as the number of streams that can be created on each test port is
limited, this will limit the total number of test ports in your configuration.

The TID Alloc.Scope property determines how Xena2544 allocates test payload identifier (TID)
values.

32 Chapter 7. Test Configuration Panel
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Fig. 7.2: Test execution control panel

• Configuration Scope: Allocates a unique TID value for each stream created. This option
ensures that only packets intended for a given port is taken into account. The downside
is that for large configurations you may quickly run out of TID values due to hardware
constraints.

• Rx Port Scope: Allocate TIDs so that all streams received on any given port have a unique
TID. TID values are reused between ports. This allow for larger configurations but the
test is no longer able to detect if packets are mis-delivered by the DUT.

• Source Port ID: Allocate TIDs so that all streams from a given port is set equal to the port
index in the configuration. This is a slight variation of the previous method.

Modifier-Based Flows

If you encounter the above mentioned limitations in a layer-2 test you can select the Modifier-
based option instead. In this mode the Xena2544 will use a single stream for all flows from one
port instead of one stream for every flow between two ports.

This will cause the Xena2544 to create the traffic flows using so-called modifiers instead of
using streams (refer to the XenaManaeger documentation for details about this). This option
will however force the Xena2544 to override the native port MAC addresses. The user can
specify the 3 upper bytes of the MAC address using the MAC Base Address option but the
lower part of the address will be assigned sequentially.

The modifier-based option is not available for layer-3 tests as we cannot emulate multiple MAC
addresses the Xena2544 needs to.

7.2.2 Port Scheduling
If enabled the Speed Reduction Sweep property will assign a small speed reduction value to each
port on a test module, so that each port on the module will get a different value. This property
is available for Blocks and Mesh topologies.
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If the Use Port Sync. Start option is checked the Start button will activate a synchronized port
start mechanism for the ports - if the chassis firmware version supports this feature.

The Port Stagger Steps property delays start of traffic generation on one port relative to pressing
Start button. The delay is programmed in steps of 64 microseconds. The Port Stagger function
works between ports on test modules installed in the same chassis.

• The 1st port will not be delayed.

• The 2nd port will be delayed with the Port Stagger Steps.

• The 3rd port will be delayed with the Port Stagger Steps * 2.

• The 4th port will be delayed with the Port Stagger Steps * 3 etc.

The maximum value of Port Stagger Steps for a port is 31250. Therefore the programmed Port
Stagger Steps must not exceed 31250/(number of ports).

ò Note

This requires that Use Port Sync. Start has been checked.

The Resulting Delta is Port Stagger Steps * 64 microseconds

s Important

Please observe that on Z800 module (Freya), you will need to uncheck the Use Port Sync.
Start box to get Xena2544 to complete.

7.2.3 MAC Learning Options
The MAC Learning Mode property can be used to instruct the testers to emit initial MAC learn-
ing packets in order for any network switches to learn the MAC addresses of the ports and avoid
excessive flooding of packets. You can specify if you want MAC learning to be performed either
at the start of every trial (the default), once when the test starts or not at all. You can also spec-
ify how many time each learning packet will be repeated every time with the Learning Frame
Count option.

If the Toggle Sync State property is checked the sync state for all selected ports will be toggled
off and on at the start of each test trial. This may ensure that the DUTs MAC-tables are cleared
at the start of each test.

The Sync State Off Period is the number of seconds to keep the port sync state off.

7.2.4 ARP/NDP Learning
This set of options control how the Xena tester advertises the IP addresses configured for its
ports. The tester will use ARP for IPv4 and NDP for IPv6. If the Enable Refresh checkbox is
checked the tester will periodically emit ARP requests (for IPv4) or Neighbor Advertisement
requests (for IPv6). The period can be set using the Refresh Period field. This will prevent the
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ARP/NDP caches in the attached router from timing out during long test period thus causing a
packet loss.

If the test uses multiple ports and/or you have used modifiers to emulate multiple IP address
on one port the number of periodic refresh requests may be large. The tester will retransmit all
refresh requests within the specified period, but it will not send them all in one batch. The tester
will distribute the necessary requests evenly over the specified period.

When the GW MAC as DMAC checkbox is checked Xena2544 will use the ARP-resolved gate-
way MAC address as DMAC address for test packets. This is only relevant for IP traffic where
the test ports belong to different IP subnets and the traffic needs to go through an IP router.

7.2.5 Flow-Based Learning
This section contains a few properties that are mainly useful when working with flow-based
switches.

The Use Flow-Based Learning Preamble property will make the Xena2544 emit a brief traffic
preamble before starting the actual test. This can be used to ensure that the flow-based switch
has learned all necessary addresses.

The Learning Frame Count controls how many frames are sent in the preamble.

The Delay After Preamble determines the size of the period between the preamble and the start
of the actual test traffic.

7.2.6 Reset and Error Handling
If Stop on LOS is enabled, Xena2544 will abort the test if a port loses the sync state during test.

When a Xena2544 test is started, the selected ports will be reset to ensure a known starting point
for the test. The Delay After Reset parameter defines how long time Xena2544 will wait after
the reset before it continues with the test.

If Port Reset is enabled, Xena2544 will reset the test ports when starting the test.

7.3 Test Types Configuration
This subpanel defines which RFC 2544 tests would want to perform and also allow you to
configure how you want them executed.

To inspect and optionally change the test properties for each test, select the test in the tree view.
The test properties will now be shown in the panel to the right.

The checkbox to the left of the test name in the tree view determines whether the test is executed
or not.

7.3.1 Throughput Test Options
Common Options

• Duration Type
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Fig. 7.3: Test type configuration panel

Fig. 7.4: Throughput test options
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Defines how to control the test duration, either by time or by frame count.

• Duration

The duration of each test trial.

• Iterations

The number of times to repeat each test trial with the same set of test parameters.

Rate Iteration Options

• Initial Rate

The starting rate in percent used by the iteration.

• Minimum Rate

The minimum rate in percent. If the iteration reaches this value the test will be FAILed.

• Maximum Rate

The maximum rate in percent. If the iteration reaches this value the test will PASS.

• Resolution Rate

Defines the minimum difference between two rate iterations. If the difference between
the next and the last rate iteration is less than this value the test is stopped and the last
successful rate is reported.

• Rate Result Scope

Determines the scope of the rate result.

– The Common Result setting will iterate towards a single throughput rate result for
all ports, which will be the lowest common rate found. This is the default setting.

– If Per Source-Port Result setting is selected the Xena2544 will attempt to iterate a
separate rate value for each source port. This will obviously produce a (potentially
different) result for each source port.

• Enable Fast Search

The default iteration algorithm used is a standard binary search, where the next attempted
rate is found as the mean value of the sum of last passed and the last failed rate. If the
fast search property is enabled the algorithm will take the measured loss rate into ac-
count when iterating down.This may in many cases result in a substantial reduction in the
number of trials needed to reach the throughput rate result.

Pass Criteria

• Use Pass Threshold

Selecting this property will allow you to specify a pass threshold value. If the test result
is below this threshold the tested will be FAILed.

• Pass Threshold

The pass threshold explained above.
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• Acceptable Loss

Allow you to specify an acceptable loss in percent of the port rate. Normally this would
be zero but for certain network types (such as satellite links) a certain amount of frame
loss is acceptable.

Test Data

• Collect Latency/Jitter

If enabled, latency and jitter will also be collected.

7.3.2 Latency & Jitter Test Options

Fig. 7.5: Latency & jitter test options

Common Options

• Duration Type

Defines how to control the test duration, either by time or by frame count.

• Duration

The duration of each test trial.

• Iterations

The number of times to repeat each test trial with the same set of test parameters.

Rate Sweep Options

• Start Rate

The starting rate in percent of the port rate used by the rate sweep.

• End Rate

The ending rate in percent of the port rate used by the rate sweep.
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• Step Rate

The increments in rate percent for each step in the rate sweep.

Misc. Options

• Latency Mode

The latency mode used when measuring the latency.

• Relative to Throughput

If checked the starting and ending rates will be calculated relative to the result from a
preceding throughput test for the same frame size. If the throughput test has not been
performed in the same test this setting is ignored. If the throughput test has not been
performed in the same test this setting is ignored.

7.3.3 Frame Loss Rate Test Options

Fig. 7.6: Frame loss test options

Common Options

• Duration Type

Defines how to control the test duration, either by time or by frame count.

• Duration

The duration of each test trial.

• Iterations

The number of times to repeat each test trial with the same set of test parameters.

Rate Sweep Options

• Start Rate

The starting rate in percent of the port rate used by the rate sweep.
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• End Rate

The ending rate in percent of the port rate used by the rate sweep.

• Step Rate

The increments in rate percent for each step in the rate sweep.

Pass Criteria

• Use Pass/Fail Threshold

Selecting this property will allow you to specify an Acceptable Loss value. If the test
result is above this value the tested will be failed.

• Acceptable Loss

Allow you to specify an acceptable loss in percent of the port rate or as a frame count.
Normally this would be 0 but for certain network types (such as satellite links) a certain
amount of frame loss is acceptable.

• Use Preemptive Stop

If this option is enabled, the test that is destined to FAILED will be stopped and the next
test will start. This will shorten the total test duration.

Convergence

• Gap Monitor Enable

Selecting this property adds Gap Monitoring to the Frame Loss Rate Test. With this
convergence time can be measured. The result will appear in the final report.

• Gap Monitor Start

Specifies the time period with no packets received that will trigger the gap monitor start.

• Gap Monitor Stop

Specifies the number of packets to receive to stop the gap monitor.

7.3.4 Back-to-Back Test Options
7.3.5 Common Options

• Duration Type

Defines how to control the test duration, either by time or by frame count.

• Initial Duration

The initial and maximum burst duration

• Iterations

The number of times to repeat each test trial with the same set of test parameters.
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Fig. 7.7: Back-to-back test options

7.3.6 Rate Sweep Options
• Start Rate

The starting rate in percent of the port rate used by the rate sweep.

• End Rate

The ending rate in percent of the port rate used by the rate sweep.

• Step Rate

The increments in rate percent for each step in the rate sweep.

• Burst Resolution

Defines the minimum difference between two burst size iterations. If the difference be-
tween the next and the last burst size iteration is less than this value the test is stopped and
the last successful burst size is reported.

ò Note

For each rate step, Xena2544 uses iterative binary search algorithm to search for the maxi-
mum burst size without frame loss. Similar to throughput test where the search is on traffic
rate with initial, minimum and maximum rate values, back-to-back test searches on burst
size with initial, minimum, and maximum burst size values. The Initial Duration defines the
initial and maximum burst size value. The minimum burst size value is always 100 frames.

If Duration Type is time, Xena2544 will internally convert the time duration into the equiv-
alent burst size.
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CHAPTER

EIGHT

SELECTED PORTS PANEL

This panel allow you to control which ports are used in the test and also to configure the port
properties. The most common port properties are available in the top port grid whereas other
port properties are available in the tabbed view at the bottom.

Fig. 8.1: Selected ports panel

8.1 Port Grid
The grid view at the top of the panel show the ports that have been selected for use in the test.
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8.1.1 Adding or Removing Ports
You can add ports to the test configuration as described in the Physical Ports Panel section
above.

To remove one or more ports form the test configuration select the ports and press the Remove
Port(s) button in the toolbar below the grid. Alternatively, you can right-click on the selected
ports and select the Remove Port(s) popup menu item.

8.1.2 Port Grid Columns
The grid view contains the following columns:

• Port Name

The name (ID and type) of the port.

• Port Speed

The physical port speed to use in the test. Normally this should be left at the default
AUTO value, but certain DUTs require that the port speed is fixed to a specific rate.

• IP Address

The IP address that you want to use for the port1.

• Prefix

The decimal network prefix for the address1.

• Gateway Address

The gateway address for the assigned IP address. This field may be left empty if the ports
are located on the same IP subnet1.

• Protocol Segment Profile

The protocol segment profile to use for this port. Profiles can be created, edited and
deleted in the separate Protocol Segment Profiles panel.

8.2 Port Properties Panel
Below the grid view you will find a tabbed panel containing less-frequently-used port properties.

8.2.1 Main Port Properties
Physical Port Properties

• Inter-Frame Gap

Specifies the minimum gap between frames generated for a port, expressed as a number
of bytes.

1 These columns are only enabled if the selected protocol segment profile defines an IPv4 or IPv6 segment.
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• Speed Reduction

Specifies an optional speed reduction on the transmit side of the port, expressed as a ppm
value.

• Enable PAUSE Mode

Controls whether the port responds to incoming PAUSE frames.

• Enable Auto-Negotiation

Controls whether auto-negotiation for the port is enabled or not.

• Latency Offset

An optional offset in nanoseconds for the port which is used for latency measurements.
You can measure an appropriate value for this by looping two test ports together and
performing a latency test. The resulting average latency of this test should be zero. If this
is not the case you can adjust the Latency Offset value until you reach a zero value. Then
you can use the calibrated value in other tests.

Port Rate Cap

• Rate Cap Type

Allow you to specify a rate cap type for the port. If enabled the port rate will be capped
with the value specified. No changes are performed to the port physical rate (use the Port
Speed property described above for that). Instead the capped rate is used when calculating
the port rates, frames to transmit, etc. It is possible to specify custom rate cap profiles
which may show up in this control. See below for instructions.

• Rate Cap Value

The port cap value and unit to use if the Rate Cap Type property is set to Custom Rate
Cap.

Peer Negotiation

• Enable Auto Negotiation

If checked the port will respond to incoming auto-negotiation frames.

• MDI/MDIX Mode

Enables control over the port MDI/MDIX mode.

8.2.2 Address Properties
Public Address

• Public IP Address

If a port is located behind a NAT firewall/router it may be necessary to provide the public
IP address offered by the NAT firewall/router. The Valkyrie2544 will then perform an
ARP request for the public IP address before starting the test, in order to avoid packet
loss due to an initial ARP phase. The real (internal) IP address of the port must still be
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configured in the main port grid as this may be used to send Gratuitous ARP packets from
the port to the router before starting the test.

• Public IP Prefix

The network prefix value for the public IP address.

Remote Loop Address

• Remote Loop IP Address

When a port with layer-3 protocol segments (IPv4/IPv6) has been configured as a looped
port you must specify the IP address of the remote port so that the Xena tester can perform
an ARP request for the MAC address.

• Remote Loop MAC Address

When a port with pure layer-2 protocol segments (Ethernet + optional VLAN) has been
configured as a looped port you must specify the MAC address of the remote loop port to
avoid excessive flooding.

8.3 Changing Settings on Multiple Ports
It is possible to change properties on multiple ports at the same time by selecting multiple ports
in the grid view and then changing settings in either the grid view or the detailed settings panel
below the grid.

You can select multiple ports using standard Windows Explorer-shortcuts like Shift-click or
Ctrl-click.

You can also use the Select All Ports or Deselect All buttons the toolbar below the grid to control
the port selection state.

The only setting that does not allow this is the IP address field, as this must always be a unique
value.

8.4 Custom Rate Cap Profiles
You can define your own custom rate cap profiles for use with the port configuration panel. This
allows you to define convenient shortcuts for commonly used rates.

8.4.1 Profile Location
The custom profiles must be contained in a text file called ratecapprofiles.json, which
must be located in the <Valkyrie2544DataDirectory>Profiles directory. To browse the
<Valkyrie2544DataDirectory> select the Explore Xena Data Directory in the Xena2544
File menu.

On initial startup the Valkyrie2544 will write a file called ratecapprofiles.json.template
to the <Valkyrie2544DataDirectory>Profiles directory. You should make a copy of this
file, rename the copy to ratecapprofiles.json and use this copy as the basis for your custom
profiles. You can edit the file in any text editor, such as the standard Windows Notepad.
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Adding Profiles

Each rate cap profile must look like the following fragment:

Field Explanation

• DisplayLabel

A text label that describes your profile. This label must be unique and will be used in the
Xena2544 dropdown box that allows you to select between the rate cap profiles.

• PortRateCapValue

The rate cap value for the profile in bit/s.

• InterFrameGap: The inter-frame gap value used to calculate the corresponding Ethernet
layer 1 rate.

All rate cap profiles must be encapsulated in a set of square parentheses.
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CHAPTER

NINE

MULTI-STREAM CONFIGURATION

9.1 Overview
The default behavior of Xena2544 is to create a single stream between any two port pairs. Some-
times it is however required to exercise the values of certain address fields in the protocol headers
in order to emulate many more clients than the physical port count allows. The multi-stream
function can be used to achieve this.

When enabled the multi-stream function will use a number of streams to implement the flow
between any two port pairs. The source and destination addresses in the streams will be varied
based on certain configuration parameters.

9.2 User Interface
The multi-stream function is enabled and configured in the Multi-Stream Configuration tab, as
shown below. The top Configuration section contains the configurable parameters.

Fig. 9.1: Multi-stream configuration panel

Below the configuration setting is a table which show a preview of the resulting streams with
the current configuration parameter values. Each row in the table represent a “stream endpoint
connection” which denotes the logical connection between two test port pairs. The connection
can be unidirectional in which case it will consist of a single stream, created on the source port.
Or it can be bidirectional, in which case it will consist of two streams, i.e. one stream created
on each port.
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The columns in the table show the actual values used for each stream endpoint connection. For
an IP configuration the Address columns will show the resulting IP addresses. If the configu-
ration uses pure layer-2 segment profiles (no IP segment) the Address columns will show the
resulting MAC addresses.

The total number of streams that will be generated is shown at the top of the table.

9.3 Configuration Parameters
The actual configuration parameters is described below.

• Enable Multi-Streams

Checking this option will enable the multi-stream function for the current Xena2544 con-
figuration.

• Stream Count Per Port-Pair

This value sets the stream count per port pair.

• Address Offset

The offset from zero (0) used when auto-generating the incrementing addresses. This
can be used to avoid using the default gateway for an IP subnet (which usually is
xxx.xxx.xxx.1).

• Address Increment

The incrementing value used when auto-generating the addresses.

• MAC Address Prefix

The MAC address prefix used when auto-generating the MAC addresses. This can be
used to avoid collision with the factory-assigned Xena test port MAC addresses.
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CHAPTER

TEN

PROTOCOL SEGMENT PROFILE PANEL

This panel allow you to configure the protocol segment profiles used by the test ports.You can
either use a single common profile for all ports or use a separate profile for each port. In this
way you can define an asymmetric traffic setup.

10.1 Available Profiles List
The list view at the top show all defined profiles.

Fig. 10.1: Protocol segment profiles

10.1.1 Managing Profiles
You can create and delete profiles to match the need of the current test scenario. To create a
new profile press the Add Profile button. To delete a profile select it in the list view and press
the Remove Profile button.

You can however not delete a profile that is currently being used by a test port. You can see the
number of test ports currently using a profile in the Use Count column in the list view at the
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top.To delete a profile that is in use you will first have to reassign all ports currently using that
profile to another profile.

10.1.2 Default Profiles
When you create a new Xena2544 configuration it will be populated with a number of default
profiles. You can however freely modify and even delete one or more of the default profiles.

If for some reason you want to restore the default profiles you can press the Restore Default
Profiles button. This will unconditionally remove all current profiles (also those that are in use)
and restore the default set. All test ports will be associated with the first default “Ethernet-only”
profile.

10.2 Profile Editor
You can edit each profile by selecting it in the top list view and using the tree view control below.

10.2.1 Add and Remove Segment Headers
To add a new segment header press the Add button in the Segments section to the right. You
will then be presented with a dialog listing all built-in segment types from which you can select
one or more types to be included. If you want to use a segment not currently supported by the
Xena2544 you can add a raw segment and specify the length in bytes. You can then afterwards
edit the values in the resulting segment using the hex editor at the bottom.

You can remove one or more segments by selecting them and pressing the Remove button in the
Segments section. You can change the order in which the segment headers appear by using the
Move Up/Down buttons.

The Xena2544 will automatically adjust the value of any standard “”next-protocol” field (such
as the EtherType field) in the segment headers when other segments are added, removed or
moved.

10.2.2 Editing Field Values
The segment editor provides a tree view similar to the one found in the Wireshark protocol
analyzer. You can thus expand each segment branch to view and optionally modify the various
field values. Each field title is preceded with a small icon indicating the type of field value
(decimal, hexadecimal, binary or IPv4/IPv6 address).

Certain fields, such as the EtherType, are associated with a set of commonly used named values.
These can be selected in the Named Values column. You are however free to enter any value
you want in the Raw Value column.

You can also edit the hex value of the segment headers directly using the hex editor at the bottom
if you are so inclined.

52 Chapter 10. Protocol Segment Profile Panel



Xena2544 User Manual, Release 106.1

10.2.3 MAC and IP Addresses
The address fields in the Ethernet and IP section headers will usually be overridden by the
Xena2544 when the test streams are created:

The Source MAC (SMAC) address field in the first Ethernet segment will be set to the MAC
address of the source port.

The Destination MAC (DMAC) address field in the first Ethernet segment will be set to the MAC
address of the destination port. If an IP segment has been defined and a gateway IP address is
defined for a source port, the Xena2544 will however attempt to resolve the MAC address of the
gateway using ARP or NDP and wil then use this MAC address as the DMAC.

The IP Source/Destination Address fields in the IP segment header will be set to the values
configured on the ports, as explained in the Selected Ports panel section above.

This replacement will however only be performed if you leave the fields at their default (all-
zeros) value. If you specify anything else this value will be used instead.

10.3 Modifiers
It is possible to attach a modifier definition to one or more fields. A modifier will exercise the
field with various values during the test and can be used to emulate a certain dynamic behavior.
Modifiers are often used to exercise either the VLAN PCP or the IP DHCP fields. Alternatively
one could apply modifiers to address fields like the DMAC field or the source or destination IP
address fields.

10.3.1 Adding a Modifier
To add a modifier to a field simply select the field and press the Add Modifier button in the
command panel to the right or right-click and select the Add Modifier popup menu option. A
Create New Modifier dialog will now be shown. The content of the dialog will depend on the
type of field. Most fields will use the Basic Modifier dialog shown below to the left. If the
selected field is an IP address the IP Modifier dialog shown below to the right will be used
instead.

Fig. 10.2: Basic modifier
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Fig. 10.3: IP modifier

Fill in the various field values and press the OK button to add the modifier to the field. Once a
modifier has been added to a field this will be indicated by a small blue M icon as shown in the
screenshot above.

10.3.2 Editing a Modifier
To edit an existing modifier either select the field and press the Edit Modifier button in the
command panel to the right, or right-click and select the Edit Modifier popup menu option.
You will see the same dialog as was used to create the modifier.

10.3.3 Removing a Modifier
If you want to remove a modifier from a field simply select the field and press the Remove
Modifier button in the command panel to the right, or right-click and select the Remove Modifier
popup menu option.

10.3.4 Limitations
There is a limitation on the maximum number of modifiers that can be defined for each test
stream. The limitation is specific for the test module type to which the port belong. Refer to the
Xena Test Module Comparison Page for further details.

10.4 Value Ranges

Fig. 10.4: Value Ranges

54 Chapter 10. Protocol Segment Profile Panel



Xena2544 User Manual, Release 106.1

A Value Range is intended to exercise one or more fields in a Xena2544 protocol segment
profiles with varying values. It is kind of similar to the hardware modifier explained above,
with the following differences:

• A Modifier is handled by hardware and varies a field value between packets on the same
stream.

• A Value Range is handled by software and varies a field value between different streams.
All packets on the same stream have the same value.

• A Value Range is defined on a field in a protocol segment profile, just like a modifier. It
will then be used for all streams created on a port which is assigned this profile.

• Value ranges can be used for both normal single-stream and advanced multi-stream sce-
narios. For normal scenarios it is most applicable for mesh configurations where multiple
streams will be created on each port.

There is no limit to the number of values ranges added to a configuration. It is also possible
to add both a modifier and a value range to a field. Whether that would yield usable results is
unclear but it might be useful for larger fields.

10.5 PCAP Import
You can import the protocol segment structure from a PCAP file captured using Wireshark or
any other capture application capable of generating a standard PCAP file. If the file contains
multiple packets Xena2544 will display a list allowing you to select the desired packet.

Xena2544 will attempt to decode the packet and display the known protocol headers and their
fields. Any unknown fields will be displayed as a raw segment. As there are limitations in the
max.size of a custom segment the import may not be possible in some cases. The import dialog
will inform you about this if the situation arises.
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CHAPTER

ELEVEN

REPORT OPTIONS PANEL

The Reporting Options panel contains a number of options that affect the way reports are gen-
erated for the test.

11.1 Report Identification
This section contains a number of options that can help identify the test context.

• Customer Name

The name of the customer for which the test is performed.

• Customer Service/Access Id

These two options allow you to provide details about the network circuits you are testing.

• Comments

Allows you to provide any multi-line comments for the test configuration.

11.2 Report Generation Options
This section contains options that affect the way reports are generated.

11.2.1 Report Naming
• Report Filename Prefix

Specifies the prefix for the report filename.

• Append Timestamp to Filename

If checked a timestamp on the form <YYYYMMDD-HHMMSS> is appended to the file-
name prefix.

11.2.2 Report Content
• Packets/Frames Terminology

This property allows you to determine whether the units of data are referred to as packets
or frames.

57



Xena2544 User Manual, Release 106.1

• Include Module Information in Report

If checked the report will also contain information for each module.

• Include Detailed Port Information in Report

If checked the report will also contain detailed results for each port. If unchecked only
the totals will be reported.

• Include Stream Information in Report

If checked the per-stream information will also be included in the reports.

• Include Charts in Report

If checked the report will include bar charts showing the test results. This is only appli-
cable for PDF type reports.

• Throughput Unit for Charts

Use this to select whether to use frames/second ot bits/second as the unit for throughput
charts.

11.3 Report Formats
This section allows you to select which types of reports will be generated. You can enable
several types. The generated report files will be given a file extension that matches the selected
type, i.e. .pdf for PDF files and so forth.

11.3.1 XML Report Specification
You can find the specification for the XML Report here.

In the Report formats section you can also activate the Also Log Intermediate Results option. It
will log intermediate results for each test type to separate CSV log files (one for each enabled
test type) located in the Result Log subdirectory in the main Xena2544 Reports directory. If
you check Add Timestamp For Each Line each line in the Intermediate Results file will include
a timestamp. If you check Use Report Name Prefix the Report Name Prefix will also be used
for naming of the intermediate result files.
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TWELVE

RESULT DATA PANEL

The Result Data panel will display both polled progress data and result data for the tests being
executed in a grid view. Each result will be shown in a single line in the grid.

The polled progress data is updated periodically while the current test trial is executing and will
be shown with an italics font. After the test trial has completed the result data for that trial will
be calculated and shown with a normal font.

The Result State column will shown the state of the current trial run. While the test trial is in
progress the state will always be (pending). A trial result may be final in which case the column
will show either PASS or FAIL, depending on the test outcome. If the test needs to perform
another iteration the state will again be (pending).

The columns used will depend of the test being performed. Most tests will provide a set of totals
values and a set of per-port values but as stated this depends on the test.

Most cell values will be displayed using the normal font color. Values that indicate an error,
such as a non-zero loss value, will be displayed with a red font color.
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THIRTEEN

CONFIGURATION ERRORS PANEL

This panel will show any configuration errors detected by the program when you attempt to
execute a configuration. If any such errors are found the panel will be shown and the execution
attempt will be aborted. You will have to correct any reported errors before the program will
allow you to execute the configuration.

Fig. 13.1: Configuration errors panel

Each error will be shown in a separate line in the panel. If you double-click on an error message
you will be taken to the relevant configuration panel that will allow you to correct the error.

This panel is by default found in the lower auto-hiding panel group. By “auto-hiding” we mean
that the panel is initially hidden but will popup either if the panel tab is clicked or if the appli-
cation decides that it is necessary to direct the attention of the user to the panel. You can make
the panel visible always by clicking the little “pin” icon in the top-right of the panel header.
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FOURTEEN

TROUBLESHOOTING

This section contains some guidelines when you encounter a problem with Xena2544,
Xena2889, Xena3918, Xena1564, and XenaManager and want to obtain help from your sup-
port representative.

14.1 Basic Instructions
This section explains how you should report a problem to your support representative.

14.1.1 Describe the Problem
To enable fast resolution of your problem we request that your support request contains the
following information:

• Name and version of the Xena test software used (the version can be seen in the main title
bar)

• A description of what you are trying to do with the software.

• If the software misbehaved please describe what you actually encountered and you ex-
pected instead.

• Screenshots of any error situation.

• The test configuration file for the application (contained in the support archive).

• Any debug log files for the application (contained in the support archive).

14.1.2 Create a Support Information Archive
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The Xena test applications include a menu entry called Create Support Information Archive
which will create a compressed ZIP archive containing both the currently loaded configuration
file and the content of the Logs and Settings directories. This file can then be emailed to your
support representative.

For the Xena2544 and similar test applications this menu entry is located in the Help menu. For
the XenaManager application it is located in the Tools ribbon menu.

ò Note

For the Xena2544 and similar test applications it is important that the configuration file used
when the problem was detected is loaded when the support archive is generated. Otherwise
the configuration file will not be part of the archive.

14.1.3 Attach Screenshots
Screenshots are a great and easy way of communicating what you see on the screen. To obtain
a screenshot of a running program and send it to Xena support perform the following actions:

1. Point your mouse inside the program window.

2. Press the Alt-PrintSc keys simultaneously.

3. Switch to your email program and start a new email message.

4. Press Ctrl-V or select Paste from the menu (most likely the Edit menu) to insert the
screenshot into the email.

14.2 Additional Details
This section goes into a bit more detail about the various items contained in the Xena Support
Archive mentioned above.

14.2.1 Configuration Files
The Xena test applications keeps their configurations in special files with an application-specific
extension. The extensions used are as follows:

• Xena2544: .x2544

• Xena2889: .x1564

• Xena3918: .x3918

• Xena1564: .x1564

• XenaManager: .xmcfg

The configuration files will be located in a common Xena data directory
on your PC. More specifically they will be located in the following path:
C:<UserAppDataDir>Xena<XenaTestApplication>. The <UserAppDataDir> direc-
tory depends on your Windows version.
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The Xena test applications include a menu entry called Explore Xena Data Directory in the File
menu that will open a Windows Explorer in the correct directory, regardless of the Windows
version.

14.2.2 Debug Log Files
The Xena test applications logs certain events and errors to a series of debug log file located
in the Logs subdirectory under the above mentioned main application data directory. If you
encounter errors it may help the support if you include these files in your support request.
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FIFTEEN

USING XENA2544 FOR PRODUCTION LINE TEST
CASES

You can use Xena2544 for production line test solution for networking devices that use Ethernet
traffic, such as switches, NICs, routers, GPONs, cable modems, EOC, power modems and so
on.

The solution consists of dedicated hardware and software from experienced test & measurement
experts and is designed to be flexible, scalable and very easy to use.

Xena2544 enables networking equipment manufacturers (NEMs) to quickly detect performance
issues and verify new features before the devices under test (DUTs) leave the factory.

15.1 Aggregation Test Case
Aggregation test case designed for PON . As a PON, there will be an aggregated interface and
multiple LAN ports. All LAN ports will upstream to the aggregated port and downstream from
the aggregated port to each LAN port.

The testbed setup is shown as in Fig. 15.1.

The Aggregation test case can be implemented by Xena2544 with Block topology +
Bidirectional traffic.

1. Select all the test ports.

2. Choose Block topology and Bidirectional traffic.

3. Assign one port (aggregation port) to a group, and the others (LAN ports) the other group.

15.2 Each-Other Test Case
Each-Other test case which designed for the switch, router and so on. This test is used to test
the whole LAN ports performance. This test case will make the DUT ports into multiple pairs
of test ports, like 1 & 2, 3 & 4 and so on. And send streams to each other. So it would ask the
customer to add the even number of ports to the port map.

The testbed setup is shown as in Fig. 15.4.

The Each-Other test case can be implemented by Xena2544 with Pairs topology +
Bidirectional traffic.
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Fig. 15.1: Aggregation Test Case diagram

Fig. 15.2: Set topology to Block + Bidirectional
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Fig. 15.3: Assign one port to a group and others the other group

Fig. 15.4: Each-Other Test Case diagram
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Fig. 15.5: Set topology to Pairs + Bidirectional

Fig. 15.6: Assign one port to West group and another to East group, and pair them
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1. Select all the test ports.

2. Choose Pairs topology and Bidirectional traffic.

3. Assign one port to West group, and another to East group. Pair them.

15.3 Router Test Case
Router test case which designed for router. One port is assigned as the WAN port, and others
will be assigned as LAN ports. Test will send one stream from each LAN port to WAN port and
send one stream from WAN port to each LAN port.

The testbed setup is shown as in Fig. 15.7.

Fig. 15.7: Router Test Case diagram

The Router test case can be implemented by Xena2544 with Block topology + Bidirectional
L3 traffic.

1. Select all the test ports.
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Fig. 15.8: Set topology to Block + Bidirectional

Fig. 15.9: Assign one port to a group and others the other group. Assign L3 profile to ports
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2. Choose Block topology and Bidirectional traffic.

3. Assign one port (WAN port) to a group, and the others (LAN ports) the other group.

4. Use L3 profile on ports.
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SIXTEEN

GLOSSARY OF TERMS

Blocks Typology
A topology where each port is associated with either the EAST or the WEST group. Each
port in the EAST group will then communicate with all ports in the WEST group, and vice
versa. There are thus no direct relation between ports like there are for the Pairs topology.
The transmit and receive roles of the ports are determined by the Direction setting.

Direction
Denotes the direction of the traffic flows in relation to the group definitions. The direction
can be either unidirectional or bidirectional. Unidirectional flows can be either EAST-to-
WEST or WEST-to-EAST.

DUT
Device Under Test

FDV
Frame Delay Variance

FTD
Frame Transfer Delay

Iteration
Each test-type can be configured to repeat the test runs associated with the test-type a
number of times. Each of these additional runs is called an iteration.

Mesh Typology
A topology where all ports communicate with each other. The direction will always be
bidirectional and the EAST/WEST group attribute is not used.

MPLS
Multiprotocol Label Switching (MPLS) is a routing technique in telecommunications net-
works that directs data from one node to the next based on labels rather than network
addresses.

Pair Typology
A topology where each port is associated with exactly one other peer port. The ports
must be associated with opposing EAST/WEST groups. A test configuration can contain
several port pairs. The transmit and receive roles of the two ports are determined by the
Direction setting.

PON
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A passive optical network (PON) is a fiber-optic telecommunications network that uses
only unpowered devices to carry signals, as opposed to electronic equipment.

Run
Run A “test run” (or simply “run”) denotes the part of the test configuration that is associ-
ated with a single test-type and a single packet size. This concept is used for the purpose
of progress reporting. A test configuration that specifies the use of e.g. 5 packet sizes and
has enabled 3 of the possible 4 test-types will thus consist of 5*3 = 15 runs.

Test Type
Denotes one of the the four types of tests according to RFC 2544: Throughput, Latency
(and Jitter), Loss, and Back-to-Back (a.k.a. Burst).

TG
Traffic Generation

TID
Test payload identifier

TPLD
Test payload

Trial
A “trial” denotes a single execution of an iteration.

VLAN
Virtual local area network (VLAN) is any broadcast domain that is partitioned and isolated
in a computer network at the data link layer (OSI layer 2).
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